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Peterborough Photographic Society 
The new web-site: www.peterboroughps.org.uk 

Introduction 
A major thrust behind the design of the new web-site was to make it more interactive - to provide facilities 

for members to display their photographs, discuss things with each others, etc. 

The public face of the site is not much different from the old site, it provides information on things like our 

programme of Tuesday night meetings, important dates and rules for competitions, etc. To get to the new 

facilities you need to “log in”. Before you can log in, you must be registered as a user of the site and that 

will happen when you (re)join for the 2015-16 season. Your user-account will be created by the 

membership secretary once you have (re)joined. 

First steps 
When the membership secretary creates your account, you will get an email (sent to the email address you 

gave when you filled in your membership form - so make sure it is legible and correct!). The email should 

come from admin@peterboroughps.org.uk, have the subject “Account details for <Your name> at 

Peterborough Photographic Society” and look something like this: 

<Your name>, 
 
Your account at Peterborough Photographic Society has been activated. 
 
You may now log in by clicking this link or copying and pasting it into your 
browser: 
 
http://www.peterboroughps.org.uk/pps/user/reset/105/1441534569/LAgpGw83elKXl0Fra-
5nvQdK_46tQ327HLb-WlImAdE 
 
This link can only be used once to log in and will lead you to a page where you can set 
your password. 
 
After setting your password, you will be able to log in at http:// 
www.peterboroughps.org.uk/pps/user in the future using: 
 
username: <Your name> or <your@email> 
password: Your password 
 
--  Peterborough Photographic Society 

 
Click the link and you will be taken to the web-site and asked to set your own password. 

http://www.peterboroughps.org.uk/
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A common reason for websites getting hacked is that users choose passwords that are easy to guess - 

“password123”, their user-name, etc. To try and counter this, we have imposed some rules: 

 Passwords must be at least 8 characters long, 

 must contain at least one lower case letter, one upper case letter and one digit, 

 must not contain your username, 

 must not be one you have used before. 

Enter a new password that conforms to these rules and that you think you can remember. Then enter it 

again in the “Confirm password” field. This tries to prevent you making some small error in typing your 

password which will prevent you from logging in next time. 

NOTE: Passwords are case sensitive: “password” is different from “Password”! Make sure you enter 

passwords exactly as given. 

Enter the password shown in the email above 

Enter a new password you can remember 

Type it again - make sure it is exactly the same! 
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I would recommend using a random password generated by a site such as https://www.random.org and 

then keeping a note of it. (I wouldn’t recommend writing down important passwords like your online bank 

account, but for something like PPS the world is going to end if someone discovers it ...). 

Scroll down to the bottom of the screen and click the [Save] button to save your new password. 

 

In future, you will be able to log in using either your user name (which will simply be your name) or your 

email address and the password you just set. 

Log in 
Once you are set up, you log in by visiting the site at www.peterboroughps.org.uk and clicking the “Log in” 

link at the top-right corner of the screen 

 

Save button 

Log in link 

https://www.random.org/
www.peterboroughps.org.uk
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Managing your account 
Once you are set up and running, there are two things I would like you to do: 

1. Add a photo of yourself to your account so that other members can put names and faces together, 

2. Add your address so that other members can contact you and see where you are (shown on the 

map - Location of members - accessed from the supplementary menus at the bottom of the page). 

I assume you joined a photographic society because you wanted to meet and get to know like-minded 

people. Therefore, it seems reasonable that you are willing to share some basic information about yourself 

with other members. 

The Society has adopted the following policy concerning the management of personal information: 

Peterborough Photographic Society complies with the Data Protection Act 1998. Under the Act, the 

Club is a data controller exempt from notification. 

The Club collects and holds personal information about members. This includes name, address, 

telephone number, e-mail, membership duration, scores obtained in competitions, records of work 

shown at external competitions, and permission to use images on the web site. Any member 

wishing to verify the personal information held by the Club should apply to the Secretary. 

Personal contact details are used only for the administration of the Club, and are distributed only to 

Committee members, and to others approved by the Committee for specific purposes. 

Contact details may be held about prospective members while they decide whether to join. Contact 

details are held about previous members for 1-2 years, in case they decide to re-join. 

In accordance with this, any information you enter here will only be available to other members and is not 

visible or accessible to anyone who is not logged in to the site. You can check this by logging out (click the 

“Log out” link at the top right of the page) and view the site as any member of the public who is not logged 

in would see it. 

Uploading a picture of yourself 

 Log in to the web-site 

Type you name or email address 

Type you password - it is case sensitive, remember 

Type you name or email address 

Click to log in 
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 Get to your account by clicking your name where it is shown at the top right corner of the screen. 

 
 You will see your details as they currently stand: 

 

(For some reason, it will show your location as in the Central Highlands - not sure why - I am 

working on hiding this map until you have entered a real location - i.e. your post code!) 

 Click on the “Edit” tab just below your name. If you scroll down to just below the boxes to change 

your password, you will find the area where you can upload a picture: 

 
 Click the [Browse] button and the usual file selection dialog for your operating system will open to 

allow you to find the picture file you want to upload. This file should be in .jpg, .jpeg or .png format, 

not more than 1024x1024 pixels and not more than 800kb. Your picture on the site is normally 

shown much smaller, so the file you load can be quite a bit smaller than the maximum allowed and 

still work well. Select the file in the normal way, press the [Open] button and the file will be 

uploaded and displayed. 

 Click the [Save] button at the bottom of the screen to save your changes. 

Click to view/edit your account 

Click to edit your account 

Click to upload picture 
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Add your address 

 If you are not already there, log in to the web-site, get to your account by clicking your name where 

it is shown at the top right corner of the screen and click on the “Edit” tab just below your name (as 

in the first three steps above). 

 Click the “Main profile” tab 

 
 

 You will now see your profile where you can enter whatever details of your address and phone 

that you would like other members to be able to see. To appear on the map of members’ 

locations, the critical piece of information is your post code. 

 

Click this tab 
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 You can also add details like your photographic qualifications 

 Click the [Save] button at the bottom of the screen to save your changes. 

If you now go back to viewing your profile (click the View tab just below your name) you will see your 

changes. 

 

Now the user’s image and address are shown and the location shown on the map is correct. If we look 

at the map of user locations (click on the link in the Supplementary menus at the bottom of the page), 

this member will appear on the map. 
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What to do if you forget your password 
If you lose or forget your password - don’t worry, help is at hand. 

On the log in form (which you get to by clicking the “Log in” link at the top-right), there is a link “Request 

new password”.  

 

Click this link and you will see: 

 

Click this link to view the map 

Click  on a pin to 
see the details 

Request new password link 
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Type in your user name or email address and click the [E-mail new password] button. You should get an 

email from  admin@peterboroughps.org.uk with the subject “Replacement login information for <Your user 

name>  at Peterborough Photographic Society” and look something like this: 

<Your user name>, 
 
A request to reset the password for your account has been made at Peterborough 
Photographic Society. 
 
You may now log in by clicking this link or copying and pasting it to your 
browser: 
 
http://www.peterboroughps.org.uk/pps/user/reset/105/1441543141/VAIEOVOgVoqplZAHxOJeZLgMwXU
ELfpJozZjcYzTGQg 
 
This link can only be used once to log in and will lead you to a page where you can set 
your password. It expires after one day and nothing will happen if it's not used. 
 
--  Peterborough Photographic Society team 

Click the link in the email and you will see this: 

 

Click the [Log in] button and you will see a form where you can set a new password. The rules are as before. 

 

Scroll to the bottom of the page and click the [Save] button to change to your new password.  

Type new password 
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The home page 
The main menu, in blue across the top, gives access to the most important content - like the club’s 

programme and competition arrangements, photo galleries, etc. 

The supplementary menus at the bottom give access to less exciting content like our membership rates and 

various policies, terms & conditions, etc. 

The bulk of the page consists of items that are dynamically updated as new material is added - like 

forthcoming events and news items. 

The rolling slideshow show cases some of our images - after all we are a Photographic Society so I think our 

front page should include photos! At the moment they are all mine - but that can quickly change if some 

others would like to offer images to be included (the available images are randomly sequenced and there 

can be as many as we like). 
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Log out link 

Click to view/edit your account Main menu 

Welcome message - this is will stay here 

News items - these will (hopefully) update frequently

 

 

The next 5 club events 

Supplementary menus 

Either click the title of an item 
or the “Read more” link to view 
the full item 

Rolling slide show
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Adding photos to you gallery 
 Log in and select My Gallery - Upload a photo from the main menu: 

 
 You will get to the “Create Photo” screen. Click the “Browse” link to start uploading a photo 

 
 You will get the “Upload a new file” screen. Click the [Browse] button and select the file you want 

to upload. When the file has been selected, click the [Upload] button and you will see a progress 

bar as it uploads 

 
 Once the file has uploaded, click the [Next] button 

 
 Enter the “Alt” and “Title text” and then click the [Save] button. The Alt text is shown when you 

mouse over the image and it is also the text that a visually impaired person will hear from a screen 

reader - so it is quite important. The Title text is used for captioning (and I don’t think it is actually 

Browse link 

Browse button Upload button 

Next button 
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used anywhere at the moment). 

 
 This will take you back to the “Upload a new file” screen (because, in some circumstances you can 

upload multiple images - but not here!). Close this screen by clicking the × at the top right corner: 

 
 This brings you back to the original screen, now showing a thumbnail of the photo. Fill in the other 

fields. The “Title” here is the one that will be used when the photo is viewed. The “Description” will 

be shown below the photo. Choose the Creative Commons licence you wish to grant for use of the 

photo and finally decide whether the photo is visible publically or only to other PPS members. 

Finally, click the [Save] button at the bottom. 

 

Close 

Choose the licence 

Do you want the photo to be publicly 
visible, or visible to members only 

Save button 
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 The photo will be displayed. 
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Your gallery 

Your gallery will display whatever photos you have loaded. Visit it by clicking the My Gallery button in the 

main menu. 

 

  

Click to select image 

Turn thumbnails 
below the main 
image on or off 

Show image in a 
new window as 
big as possible 

Make the 
viewer full 
screen 

Click the title to view the image details 



admin@peterboroughps.org.uk 16 PPS web-site, Stuart Ball, 01/10/2015 

View other members’ galleries 

Click the Photo button in the main menu to see what galleries are available. Clicking on a member’s name 

will take you to their gallery. It will appear as above. 

 

  

Click to view the gallery 
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Forum 
To get to the discussion forum select Forum - General discussion from the main menu. This will show you 

an overview of recent discussions. 

 To view a particular discussion, click on the topic’s title 

 To start a new discussion, click the [New topic] button 

 

Existing discussion 

When you view an existing discussion you will see a “thread” starting off with the initial post that started 

the topic, followed by one or more replies. You add your own comment to the thread by clicking a [Reply] 

button. 

Click to view this discussion 

Click to start a new topic for discussion 

This topic has one reply so far 
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Starting a new topic or replying 

When you click the [New topic] or [Reply] buttons, you will get to a screen which allows you to type your 

comment. It has a box to type a “Subject” and then a an editor in which you can type your comment/reply. 

This is pretty much like composing an email and should be fairly familiar to most people. The editor has 

buttons to format the next (embolden, italicise, etc) and to insert hyperlinks and images. The process of 

inserting an image into the text is much like that described above under “Adding photos to you gallery”. 

Finally, you can click the [Preview] button at the bottom to see what you post will look like, and the [Save] 

button to actually save it and permanently add it to the discussion. You can edit your own posts at a later 

date if necessary (click the [Edit] button). 

Reply button 

Reply button 
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Add a photo Add a link 

Save & Preview buttons 


	Introduction
	First steps
	Log in
	Managing your account
	Uploading a picture of yourself
	Add your address

	What to do if you forget your password

	The home page
	Adding photos to you gallery
	Your gallery
	View other members’ galleries

	Forum
	Existing discussion
	Starting a new topic or replying


